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This manual was produced by the Royal Botanic Garden Edinburgh on behalf of the European 

Distributed Institute of Taxonomy. This is the third draft of the manual for the Taxonomic Editor and 

was based on Version 2.1.0.201002031058; it covers the basic functions of the Taxonomic Editor 

given in previous drafts with some additional functions. Updated versions of both the Taxonomic 

Editor and the user manual will be released via the EDIT WP5 website: http://dev.e-

taxonomy.eu/trac/wiki/.  
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1.0 Introduction to the Taxonomic Editor 

 

The Taxonomic Editor has been developed as part of the EDIT Cyberplatform for Taxonomy; a 

collection of tools and services which together cover all aspects of the taxonomic workflow. EDIT is a 

collection of 28 leading European, North American and Russian institutions formed in the response 

to a call of the European Commission, issued in 2004, for a “network in Taxonomy for Biodiversity 

and Ecosystem Research”.  

 

Development of the Taxonomic Editor is part of EDIT Work Package 5: Internet Platform for 

Cybertaxonomy: Tools, Sharing, Networking and Integration. The tools are all open access, free, do 

not require licenses, and are downloadable from the EDIT website. Data stored in the Taxonomic 

Editor will be linked to other applications of the Cyberplatform via the Common Data Model (CDM) 

Library, where the data is stored. So, for example, your Taxonomic Editor dataset can be easily 

published online using the EDIT DataPortal application that can extract your data from the CDM. No 

data transformation is required by you. The Editor also supports importing and exporting in a range 

of databases and taxonomic community data formats and import from Excel.  

 

The goal of the Taxonomic Editor is to provide a next-generation tool that moves beyond the form-

based data entry of web-based tools like the Berlin Model Web Editor. It has been designed with 

specific philosophies giving the user: 

 

1. All the benefits of a database without rigid data entry rules. 

 

A unique feature of the Taxonomic Editor is its parsing capability. Parsing is the action of recognising 

distinct elements within a string. This means that data can be entered as ‘free’ or unstructured text, 

and as you type the parser separates each element of the text string and puts them into the correct 

data fields within the database. This makes data entry easy, but also enables manipulation of data as 

in a standard database. 

 

The core workflow involves:  

 

i. Entering data as a normal text string in a taxonomic style.  

ii. The data is parsed as it is entered.  

iii. Reviewing whether the data has been parsed correctly and editing if necessary.  

 

2. Ability to enter data in the format required by the user. 

 

A second defining feature of the Editor is that it has been designed to minimise system intervention 

so as not to hinder the work flow. Rather than enforcing data integrity upon input, warnings are 

given when any rules have been broken. When the mouse hovers over data that has been marked as 

problematic, the problem will be explained, along with possible corrections, however the software 

will not force you to change your data.  
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3. Useability and customisation options. 

 

The Editor has been designed to feel intuitive keeping the number of new movements or gestures 

you must learn to a minimum. Also, the Taxonomic Editor allows for individual customisation of the 

fields within the data entry sheet to facilitate an efficient data entry process. For example, you can 

choose which taxonomic relationships and rank types are given as options, and for some data fields 

you can create your own options. There are also separate configurations for users using the 

Botanical and Zoological Codes of Nomenclature.  

 

You will notice that not all of the features of the Taxonomic Editor are yet functional; development 

of the application and the manual are still ongoing. Version 3 of the Taxonomic Editor will be 

released in July 2010; smaller updates will be made available on the EDIT WP5 website.  

 

4.  Bulk Editing 

 

The Taxonomic Editor has a bulk editing facility that allows you to edit several records at one time. 

This will be useful, for example, if the name of a genus has changed as well as all the species records 

associated with that genus. This saves time and improved data consistency and integrity. The bulk 

editor can also be used to merge duplicate records that may be found in large datasets after import, 

for example. 

 

1.1 About the Manual 

 

Most of the manual has been produced whilst running the Taxonomic Editor on Microsoft Vista. If 

you have a different operating system your screen may have a slightly different appearance to the 

screen shots in the manual, however the actual work flows should not be affected. Where the work 

flows may differ these have been detailed separately, however, the manual has not yet been 

completed for use on Apple Mac systems. 

 

This version of the manual for the Taxonomic Editor has been designed to provide an overview of 

the design philosophies and capabilities of the Taxonomic Editor. It is not intended to be exhaustive, 

but will allow you to make a basic taxonomic treatment. 

 

Within the work flow descriptions that follow the symbol (>) indicates a progression from one step in 

a work flow to the next. Screen shots relate to the steps in the work flow given above the screen 

shot, not below. Red arrows given in screen shots from one window/menu/box to another indicates 

that the second will appear after carrying out the action in the first. 
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2.0 Setting up the Taxonomic Editor 

 

 

 

2.1 Downloading the Taxonomic Editor  

 

The Taxonomic Editor, as well as other EDIT Cyberplatform components, can be downloaded via the 

Cybergate at http://dev.e-taxonomy.eu/platform/. There are no additional system features required 

for the Taxonomic Editor to work. 

 

1. Click EDIT Desktop Taxonomic Editor within the Cybergate. A description of the Taxonomic 

Editor and further options will appear to the right of the Cybergate. 

2. Click Download in the section on the right.   

 

 

 

You will be taken to the Taxonomic Editor Download Site. 

 

 

This section tells you how to: 

• Download and install the Taxonomic Editor for the first time. 

• Create a desktop shortcut. 

• Install updates of previously installed features. 

• Search for and install new features. 

• Remove the Taxonomic Editor. 

• Ensure that Unicode characters such as ♀ and ♂ are visible. 
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Alternatively, you can access the download site directly by entering http://dev.e-

taxonomy.eu/trac/wiki/TaxonomicEditorDownload into the address bar of your browser.   

3. Click the latest version of the Taxonomic Editor; the latest version will be specified. 

 

 

 

The following steps will differ slightly depending on whether you are using Mozilla Firefox or Internet 

Explorer and the operating system you are using. If you are using Mozilla Firefox on Vista, you will be 

taken straight to the “Save As” details pop-up box; go to Step 5. If you are using Internet Explorer or 

Mozilla Firefox on an older operating system such as Windows XP, you will see a pop-up box the 

same as or similar to the ones shown below; go to step 4. 

 

4. Click the Save button or choose the Save option. Click the OK button if necessary. The “Save 

As” details pop-up box will open; go to step 5.  

 

 
  Mozilla Firefox and Vista/Windows XP             Internet Explorer and Vista/Windows XP 

 

5. Choose a destination for the folder containing the Taxonomic Editor (Tip! You may have to 

click a Browse Folders button as shown below in order to access your computer’s directory). 

Make a note of the destination. 

6. Enter a file name or use the default file name. Make a note of the file name. 

7. “Save as type” should be Compressed (Zipped) Folder. 



 

User Manual for Taxonomic Editor (Version 2.1.0.) 5 

  

 

 

 

Tip! If you are using Mozilla Firefox and you do not see a pop-up box as shown above, your internet 

options may not be set up to ask for confirmation on where to save files that you download. The 

folder will automatically be saved to your desktop. If you wish to change this setting, see the 

Troubleshooting instructions at the end of this section. 

 

8. Click the Save button; a download progress bar will appear. The download may take a few 

minutes. 

 

 
 

You now have to extract the contents of the compressed folder; the exact method will depend on 

whether you are using Mozilla Firefox or Internet Explorer (see Extracting the Contents of the 

Compressed Folder (Internet Explorer) or Extracting the Contents of the Compressed Folder 

(Mozilla Firefox) below). 

 

Troubleshooting: Mozilla Firefox Settings 

 

If your internet settings are set up to not ask you for confirmation as to where to save files and 

folders that you are downloading, they will automatically be saved to your desktop. If you want to 

change this setting open the Mozilla Firefox start page > click on the Tools menu on the toolbar at 

“Save As” details box: 

choose a location and 

name for the folder 

(choose a new name or 

keep the default) and 

Save. 

3 
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the top of the screen > click on Options. A new pop-up box will open. Click in the box to the right of 

the text “Always ask me where to save files” and click OK: 

 

 

 

2.2 Extracting the Contents of the Compressed Folder (Internet Explorer) 

 

1. Locate the compressed Taxonomic Editor folder in the destination in which you saved it. 

2. Right-click the folder. 

3. Click the Extract Files option.  

 

 

 

A new pop-up box will open for you to choose the destination where the extracted folder 

will be placed. The default destination will be the location of the compressed folder; if you 

wish the extracted folder to be in the same place as the compressed folder there is no need 

to change the destination. 
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4. Select the destination and click the OK button. The folder will be extracted; this may take a 

few minutes.  

 

 

 

You should now create a Desktop shortcut for the Taxonomic Editor (see Creating a Desktop 

Shortcut (Windows only) on page 8). 

 

2.3 Extracting the Contents of the Compressed Folder (Mozilla Firefox) 

 

If you have downloaded the Taxonomic Editor using Mozilla Firefox, when the download is complete 

a pop-up box will open to inform you, as shown below.  

 

1. Open the folder by double-clicking it in the pop-up box: 

 

 

 

 

Alternatively, locate the folder in the destination in which you chose to save it, and double-

click the .zip folder.  

 

2. Click the Extract All Files button: 

 



 

User Manual for Taxonomic Editor (Version 2.1.0.) 8 

 

 

A new pop-up box will open for you to choose the destination where the extracted folder 

will be placed. The default destination will be the location of the compressed folder; if you 

wish the extracted folder to be in the same place as the compressed folder there is no need 

to change the destination. 

3. Select the folder destination using the Browse button or leave the default destination. 

4. Ensure “Show extracted files when complete” is selected, and click the Extract button.  

 

 

 

The contents of the compressed folder will be extracted; this may take a few minutes.  

 

You should now create a desktop shortcut for the Taxonomic Editor (see Creating a Desktop 

Shortcut (Windows only) on page 8). 

 

2.4 Creating a Desktop Shortcut (Windows only) 

 

It is recommended that you create a desktop shortcut to the file location of the TaxonomicEditor.exe 

file as soon as you have downloaded and installed the Taxonomic Editor. You will then be able to 

open the Taxonomic Editor using the shortcut instead of having to navigate to the .exe file location. 

These instructions apply only to Windows systems. 

 

1. Locate and open the extracted Taxonomic Editor folder in the destination in which you 

chose to extract the folder (if you selected the “Show extracted files when complete” option 

when extracting the folder it will automatically open).  

2. Right-click the TaxonomicEditor.exe file; a drop-down menu will appear. 
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3. Click the Send To option. 

4. Click the Desktop (create shortcut) option. 

 

 

 

This will create a shortcut on your desktop that will automatically open the Taxonomic Editor: 

 

 

 

You can double-click this icon to open the Taxonomic Editor.  

 

2.5 Opening the Taxonomic Editor 

 

1. Double-click the Taxonomic Editor shortcut on your desktop (if you have not created a 

shortcut it is recommended that you do so). 

 

A security warning may open; this is a standard Windows security warning asking for confirmation 

that you trust the source of the application.  

 

2. If you have received a Security Warning pop-up, deselect the option “Always ask before 

opening this file” – this will prevent this pop-up box from appearing every time you run the 

Taxonomic Editor. 

3. Click the Run button to continue opening the Taxonomic Editor.  
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4. The Taxonomic Editor will load and open; this may take a minute or two the first time you 

open the Taxonomic Editor. 

5. The first time you run the Taxonomic Editor, you will be asked to choose a nomenclatural 

code. Select the code you wish to use and click the OK button. 

 

 

 

A pop-up box will open confirming your choice of nomenclatural code. 

 

You can change the nomenclatural code at any time in the “Preferences” (see The Preferences 

Menu on page 29). 

 

2.6 Logging In 

 

Every time you open the Taxonomic Editor a log-in pop-up box will open. This feature is not yet 

operational but will be in the next release of the Taxonomic Editor. It will allow changes to be 

tracked if there will be multiple users of the underlying CDM data store and you need to track 

changes, each user should log in under their own account. For now, skip the log-in by clicking the 

Cancel button. 



 

User Manual for Taxonomic Editor (Version 2.1.0.) 11 

 

 

 

2.7 Downloading and Installing Updates  

 

Periodic updates of the Taxonomic Editor may be released. These can be usually be accessed via the 

Help menu of the Taxonomic Editor, however this feature is not available in this version of the 

Editor. Therefore to install updates you should remove your current version of the Editor as 

described in section Removing the Taxonomic Editor on page 12 and reinstall as described in section 

2.1 to 2.6 above. 

 

2.8 Enabling Unicode Characters 

 

The Taxonomic Editor uses the operating system's default font to display all the fields that store 

specimen data. On a Macintosh, the system font is Unicode-compliant, so there is no 

problem displaying specimen data that includes symbols such as ♀ and ♂. On some, mainly older 

Windows systems, this is unfortunately not the case. To ensure that all data will be visible on your 

system, you may need to install a Unicode-compliant font on your Window’s system. If you are 

experiencing this problem it can be resolved quite easily: 

 

• Right-click on your Desktop. 

• Click Properties in the drop-down menu > Click the Appearance tab > Click the Advanced 

option. A new pop-up box will open.  

• Click the “Item” drop-down menu and select Message Box. 

• Click the “Font” drop-down menu and select Arial Unicode MS. 

 

The Unicode characters should now appear in the Taxonomic Editor. 
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If the Arial Unicode MS font is not shown as an option in the Font drop-down menu, and you are 

using Microsoft Office 2000 or later, you can obtain the font from your Microsoft Office CD:  

5. Insert the Office CD, and do a Custom Install.  

6. Choose Add or Remove Features.  

7. Click the (+) next to Office Tools > International Support > the Universal Font icon > Arial 

Unicode MS font. 

8. Follow the instructions 1-2 above. 

 

2.9 Removing the Taxonomic Editor 

 

To remove the Taxonomic Editor from your system, locate the folder in which the taxonomic 

editor.exe file is stored on your system and simply delete the folder. If you cannot find the folder 

and you are on a windows platform and have created a desktop shortcut to the Editor you can 

determine the path to the folder by looking at the properties of the shortcut. Do this by right clicking 

on the shortcut and selecting the properties option from the drop down menu.  In the Shortcut tab 

of the properties window look in the ‘Target field’ this will reveal the location of the taxonomic 

editor.  
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Navigate to the Taxonomic Editor folder and delete it by simply clicking once on the folder and 

pressing the Delete button on the keyboard. A pop-up box will appear asking “do you really want to 

delete this folder”; press Return on the keyboard to confirm.  

 

 

 

You will also need to delete the cdm.Library folder where your local data is stored. The exact 

location of this folder will depend on your computer system. In order to locate it, run a system 

search as detailed for different operating systems: 

  

2.9.1 Windows XP and older Systems 
 

1. Click on the Windows Start button at the bottom left of your computer screen (on newer 

systems you may only have an untitled Windows icon). 

2. Select the Search button; a new pop-up box will appear. 

3. Select Search All Files and Folders; a new pop-up box will appear. 

4. Select the locations on your computer that you would like to search. 
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5. In the search bar at the left hand side of the box enter “cdm.Library”. 

6. Click the Run Search button. 

The search will be carried out and the results will be shown in the main panel of the pop-up 

box. The search will return a list of matching results. There should only be one folder called 

“cdm.Library”. 

7. Within the panel of the search box, click the cdm.Library folder once. 

8. Press Delete on the keyboard. 

A pop-up box will appear asking “do you really want to delete this folder”. 

9. Press Enter on the keyboard to confirm. 

The cdm.Library folder will be deleted. 

 

If you cannot locate your cdm.Library folder using this method, please see the Microsoft help page 

for Windows XP at: 

 

http://support.microsoft.com/kb/308895  

 

You can now delete the shortcut from your desktop: click on the shortcut, press the delete button 

on the keyboard; a pop-up will ask you to confirm the deletion; click the OK button. 

 

2.9.2 Windows Vista 
 

1. Click on the Windows Start button at the bottom left of your computer screen. The Start 

menu will open. 

2. Click in the search bar at the bottom of the menu. 

3. Enter “cdm.Library”: 

 

 

 

 A menu of matching search results will open. 

4. Click the Search Everywhere option at the bottom of the search results menu. 

A “Search results in indexed locations” window will open. At the left hand side is a list of 

locations with matching folder names. One of these will be your user location on your PC. 

5. Click the arrow icon at the left of your user directory to expand the menu. The cdm.Library 

folder will be found in the menu. 

Click the cdm.Library folder once and press the Delete button on the keyboard. A pop-up 

box will appear asking “do you really want to delete this folder”. 

6. Press Enter on the keyboard to confirm. 

The cdm.Library folder will be deleted. 

 

If you cannot locate your cdm.Library folder using this method, please see the Microsoft help page 

for Windows Vista at: 

http://windowshelp.microsoft.com/Windows/en-GB/help/ed53ade7-cfb8-425a-841d-

6a6aa6991dfe1033.mspx  

Windows Start button 
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You can now delete the shortcut from your desktop: click on the shortcut, press the delete button 

on the keyboard; a pop-up will ask you to confirm the deletion; click the OK button. 

 

2.10 Creating Multiple Datasources  

 

Multiple Datasources can be used to create separate databases or datasets within the Taxonomic 

Editor. You may want to create a separate datasource for different users or for different taxonomic 

treatments, allowing you to keep the information separate. 

 

With the Taxonomic Editor installed and open on the machine: 

 

1. Ensure that the Datasource panel is shown: 

 

Window > Show View > Datasource 

 

 

The Datasource panel will open at the bottom of the Taxonomic Editor window. 

 

2. Press the right-click of the mouse with the cursor pointing within the Datasource panel; a 

drop-down menu will appear. 

3. Click New: 

 

 

 

The “Create New Datasource” panel will appear. 

 

4. Enter a name for the Datasource in the Datasource Name field: 
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5. Click the arrow icon to the right of the Database Type field; a drop-down menu will appear. 

6. Click the “H2 Database” option. 

 

 

 

The drop-down menu will close. 

 

7. Click Next. 

 

 

 

The “Enter credentials for embedded H2 database” pop-up box will open.  

 

8. Enter a Database name (for example the name of a user or a taxonomic group). 

9. Select ICBN or ICZN as appropriate.  
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10. Click Finish.  

 

 

 

Please Note: There is no need to input a user name or password. Although you can create a user 

name and password if you wish, the enforcement of this function is not yet operational, therefore a 

user will be able to edit any datasource without using the username and password. 

 

The new Datasource will appear in the Datasource panel: 

 

 

 

The process to create new datasources can be repeated as many times as desired.  

 

2.11 Connecting to a Different Datasources 

 

The open Datasource is indicated by an open folder icon in the Datasource panel: 

 

 

 

To open a different Datasource for each tester: 

 

1. Click the right mouse button with the cursor pointing to the Datasource you wish to select. 

2. Click Connect.  
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 The “Confirm Datasource Change” pop-up box will open. 

 

 

 

3. Click OK.  

 

The Taxonomic Editor will restart with the selected Datasource open.  

 

If you are opening a Datasource with a Nomenclatural Code that is different to the preferred 

Nomenclatural Code that you selected when installing the Taxonomic Editor, you will receive a 

warning: 

 

 

 

4. Click OK; the warning will close and the Nomenclatural Code will be changed to match that 

of the Datasource. 
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3.0 Getting to Know the Taxonomic Editor 

 

 

 

3.1 Parts of the Taxonomic Editor 

 

This section gives a brief overview of the main sections of the Taxonomic Editor and some of the 

terminology you will need to be familiar with. 

 

The Taxonomic Editor has 4 main parts: (1) the Toolbar, (2) the Taxonomic Tree panel, (3) the 

Freetext panel, and (4) the Properties Sheet. Additional panels showing (5) the User Manager and 

(6) the Datasource are also available.  

 

 

 

(1) The Toolbar contains a search bar to search within your data set and the Menus (see 3.2 The 

Menus below for a list of menus available and their functions). 

 

(2) The Taxonomic Tree panel provides a taxonomic, hierarchical representation of the relationships 

between the taxa within your dataset. 

 

(3) The Freetext panel is the main data entry area. There are 2 tabbed panels in this area: Name and 

Descriptive. Only one panel is visible at a time; you can navigate between them using the tabs at 

the bottom of the Freetext panel. The Descriptive tab shows descriptive data for the open 

taxon, such as distribution information. The Names tab shows the nomenclatural information 

This section will teach you about: 

• The different parts or panels of the Taxonomic Editor. 

• The menus; their contents and functions. 

• Standard commands and functions. 

 2 

 1 

 3 

 4  5 

 6 
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for the open taxon. If you are using the Bulk Editor facility, the bulk editor panel will open in 

place of the Freetext panel. The Freetext panel is described in more detail in The Freetext Panel  

on page 23. 

 

(4) The Properties Sheet panel displays the record details of the taxon that is open and selected in 

the Freetext panel. Data can be edited directly in this panel. 

 

(5) The User Manager panel will be used to view, edit, create or delete user accounts in order to 

track changes to your data, for example “Created By” and “Updated By”; it is not yet 

operational. 

 

(6) The Datasource panel shows which datasource, or database, the Taxonomic Editor is currently 

connected to. You can connect or delete connections to different datasources or create a new 

datasource.  

 

3.2 The Menus  

 

 

 

File  The File menu has the following options: 

> New; for creating a new Taxon Node or Taxonomic Tree 

> Close; > Close All; > Save; > Save All; these functions operate on the taxon or taxa 

records that are open in the Freetext panel. 

> Import; for importing data for an existing database or file. 

> Export; for exporting data to a database or file. 

> Exit; for closing the Taxonomic Editor.   

> Recently opened records are listed at the bottom of the menu. Click on a taxon 

name in this list to open the taxon in the Freetext panel. 

 

 

 

Edit > Undo; > Redo; these commands are currently operational only when using the 

Bulk Editor (see below). 
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> Cut; > Copy; > Paste; > Delete; these commands apply to all panels of the 

Taxonomic Editor apart from the Taxonomic Tree panel where only the Delete 

function works. 

 

 

 

Bulk Editor The Bulk Editor is used to edit lists of:  

> Names 

> References 

> Authors and Author Teams 

See Bulk Editing on page 56 for further details. 

 

 

 

Window > Preferences; for managing preferences (see Customising the Taxonomic Editor 
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Customising the Taxonomic Editor on page 29). 

 > Show View; to open panels that have previously been closed (again, see 

Customising the Taxonomic Editor on page 29). 

 > Login; to open the User login pop-up box. This feature is not yet functional. 

 

 

 

Help > Help Website; to access the Taxonomic Editor Help section on the EDIT website. 

> Software Updates; to access any available updated from the EDIT WP5 website. 

> About Taxonomic Editor; to access feature, plug-in and configuration details. 

 

 

 

3.3 General Behaviours and Navigation  

 

3.3.1 Mouse and Keyboard Functions 
 

In all sections of the Editor except the toolbar clicking the right mouse button will open up a context 

menu containing a list of possible commands that can be performed on the data element the mouse 

is pointing at. When no commands are available right-click will have no effect. 

 

Most of the commands written in the manual are based on the user using the mouse. However, it is 

also possible to use the keyboard for some functions. Notably, when pop-up boxes require 

confirmation by selecting ‘OK’ or ‘Finish’, the default setting will be on the OK/Finish button, 

therefore you can select OK/Finish by pressing Return on the keyboard as well as clicking the button 

with the mouse.  

 

Keyboard arrows can be used to navigate around the Toolbar area to find menus and make 

selections. You must first click on one of the menus using the mouse, but can then use the arrows on 

the keyboard to navigate and the Return/Enter key to make your selection. 

 

3.3.2 Changing Panel Sizes 
 

Each individual panel on the Taxonomic Editor can be resized using the mouse; as you point the 

mouse arrow on the join between two panels a double-headed arrow will appear. Simply press and 
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hold the left mouse button and move the mouse until the panel is in the desired position and release 

the left mouse button. 

The entire Taxonomic Editor can also be resized in this way. It also has the standard minimise, 

maximise and exit buttons at the top right of the window.  

 

3.3.3 Opening and Closing Panels 
 

Each individual panel can be minimised/maximised using the icons at the top right of the panel, or 

closed using the ‘X’ icon on the tab bearing the name of each panel:  

 

 

 

The panels can be reopened using the Show View menu (see The Show View Menu on page 35). 

 

3.3.4 Navigating between Panels 
 

To change the active panel of the Taxonomic Editor you must navigate between them using the 

mouse; clicking in a panel will activate it. 

 

3.4 The Freetext Panel  

 

This section describes how to work within the Freetext panel. The Freetext panel has two elements; 

the Names tab and the Descriptive tab.  

 

The Freetext > Name tab is where the nomenclatural information such as accepted name, authority 

and nomenclatural reference as well as synonym information is displayed and updated. 

 

The Freetext > Descriptive tab is where additional descriptive data such as distribution, common 

names, conservation status, ecology etc is input, edited and displayed. See Adding Descriptive Data 

to Taxon on page 69 for more details.  

 

You can open either the Name or Descriptive tabs by clicking on the tabs at the bottom of the 

Freetext panel: 

 

 

 

 Close 

Maximise 

Minimise 
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3.4.1 Activating Taxon Records in the Freetext Panel 
 

Any taxon listed in the Taxonomic Tree panel can be opened in the Freetext panel by double-clicking 

it in the Taxonomic Tree panel. This is the equivalent of opening a word processing file within the 

database. The taxon record will be opened in the Freetext panel headed by a tab titled with the 

taxon name: 
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      Double-click here    and the taxon opens here      in a new tab 

 

 

Please Note: when a taxon record is first activated in the Freetext panel the default display will be 

the Names tab. 

 

3.4.2 Searching for a Taxon Record 
 

If you want to open a taxon record in the Freetext panel but you do not know its location in the 

Taxonomic Tree, you can search for the taxon using the search bar at the top of the Taxonomic 

Editor window: 

 

1. Click in the search bar. 

2. Enter a search term – this can be the full taxon name or you can use the wildcard asterisk 

(e.g. Des*, *halteralis, *halt* could all be used to search for Desmometopa halteralis). 

Please note the search is case sensitive so you must use a capital letter where appropriate. 

3. Press Return on the keyboard. 

 

The search results will appear in a new tab in the Taxonomic Tree panel as shown below. Taxon 

records with a black square icon can be double-clicked to open their records in the Freetext panel. 

Those with green circles are synonym records; those which apply to more than one accepted taxon 

record cannot yet be opened by double-clicking in the search results in this way. This problem will be 

addressed in later versions of the Editor. 
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Also in the search results are the types of taxa that you have included in your search. For example, 

the search above included Taxa, Synonyms, Names (without taxa) and Common Names: 

 

 

 

 Should you want to limit the search results to one or a sub-set of these options, you can do so by 

selecting and/or deselecting your search criteria using the drop-down menu to the right of the 

Search bar. Simply click the arrow icon to reveal the drop-down menu, and click on the available 

criteria. If the criterion is included in searches there will be a tick icon to its left. 

 

 

 

 

 

Synonyms: Those which apply to more than one 

accepted name cannot be selected as above 

Accepted Names: Can be selected – double-click 

and the taxon will be activated in the Freetext > 

Name panel 

All criteria will be included in searches 

Only (accepted) Taxa and Synonyms will 

be included in searches 



 

User Manual for Taxonomic Editor (Version 2.1.0.) 27 

Tip! If your search results do not show any taxa but you know there should be matches within your 

dataset, make sure that the search criteria are selected. If they are ALL deselected you searches will 

be unsuccessful. 

 

3.4.3 Navigating between Taxon Records 
 

It is possible to open multiple taxon records so that there are several documents open in the 

Freetext panel. Each taxon will be opened as a new document; each document can be accessed by 

clicking on the appropriate tab at the top of the free text panel. A double-arrow icon will displayed 

at the top right of the panel when there are more taxa open than are currently visible; the number 

refers to the number of open taxon records.  

 

The tabs of 2 taxon records are visible and there are 4 open taxon records that are not currently 

displayed 

 

 

 

In order to view more tabs of taxon records you can expand the width of the Freetext panel using 

the arrows that appear at the sides of the panel when you hover the mouse arrow over them (see 

Panel Sizes on page 22). Also, clicking on the double-arrow icon will reveal a list of all the open taxon 

records; those in bold are those for which the tabs are not current displayed: 

 

 

 

You can click on any of the taxon records in the drop-down list to activate that record in the Freetext 

panel.  

 

3.4.4 Closing Taxon Records 
 

You can close the activated taxon record by clicking on the Exit icon at the right of the tab: 

 

Open taxa with tabs 

not currently displayed 

Taxa with currently 

displayed tabs 
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If you want to close a taxon record for which the tab for the record is visible, click on the tab to 

activate the record and click the Exit icon as shown above. 

 

When you have multiple taxon records open, you can close a taxon record that is not being 

displayed without first having to navigate to it: 

 

1. Point the mouse arrow at the double-arrow icon at the top of the Freetext panel; a drop-

down menu will appear. 

2. Point the mouse arrow at the taxon in the drop-down list that you want to close. 

3. Click the mouse so the taxon is highlighted. 

4. Click the right-mouse button; the Close menu will appear. 

5. Click Close.  

The taxon record will close and the taxon name will disappear from the list.  
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4.0 Customising the Taxonomic Editor  

 

  

4.1 The Preferences Menu 

 

 

 

Toolbar > Window > Preferences 

 

4.1.1 Show/Hide Options of Drop-Down Menus  
 

Some taxonomic and descriptive elements of the Properties Sheet have numerous options, as is the 

nature of taxonomy, for example there are 19 options to describe the Distribution Status of a taxon. 

You may find that you only need to use a sub-set of these options.  

 

From the Preferences menu you can show or hide the options in certain drop-down boxes; this will 

reduce navigation time required to find your desired option. 

 

 Options can be amended for the following fields: 

 

> Description  > Distribution Status; for example “introduced: cultivated”, “introduced: 

naturalised”.  

> Features; the features you would like to include in your taxon descriptions, 

for example “common name”, “distribution” and “ecology”. 

   > Languages   

 

 > Taxonomic > Extension Types  

   > Marker Types  

   > Name Relationships; for example “misspelling for”, “basionym for”.  

   > Nomenclatural Code; ICBN or ICZN. 

   > Nomenclatural Status Type; for example “invalid”, “conserved”.  

   > Ranks; for example “cultivar”, “tribe”. 

> Specimen Type Designation Status; for example “epitype”, “holotype”. 

   > Taxon Relationship Type; for example “overlaps”, “excludes”.  

 

This section tells you how to customise the Taxonomic Editor to suit your own needs. You can: 

• Pick and choose which options will appear in drop-down boxes. 

• Create new options/data fields for several parts of the database such as taxon 

descriptions. 

• Choose which panels of the Taxonomic Editor are displayed.  
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To amend the options that are shown in the drop-down boxes in the above data fields, open the 

Preferences pop-up box (Toolbar > Window menu > Preferences option). The Preferences pop-up 

will open. 

 

1. The Description and Taxonomic menus given above are located in the Taxonomic Editor 

option in the menu. They can be accessed by expanding the Taxonomic Editor menu by 

clicking on the arrow icon: 

 

 

 

2. Click on the data field you would like to change from the menu on the left hand side of the 

pop-up.  

The existing options associated with the drop-down list for that data field will appear in the 

main panel of the Preferences pop-up box. By default, all of the options will be selected. Use 

the scroll bar to the right of the options list to navigate the list.  

3. Ensure that all of the options you wish to appear in the drop-down box for that data field are 

ticked, and all those you do not wish to appear are un-ticked. You will need to use the 

mouse to do this. 

You can use the Toggle button on the right-hand side of the box to select or deselect all of 

the options in the list. 

4. Click the Apply button > click the OK button to finish. The Preferences pop-up box will close 

and you will be returned to Taxonomic Editor. 
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4.1.2 Adding New Options to Drop-Down Menus 
 

For some data fields in a Taxonomic Database there are so many possible options that it is 

impractical to add all of them by default. Therefore there may be occasions where you wish to be 

able to apply a value to a data field but do not have an option to do so within the drop-down list for 

that data field, or there is no data field to accommodate the information you wish to enter.  

To allow for this, some fields allow for new options to be added: 

 

> Description  > Features; the features you would like to include in your taxon descriptions, 

for example “common name”, “distribution” and “ecology”.  

You can add a new data field to the Descriptive panel found in the Freetext 

panel. 

> Taxonomic > Extension Types You can add a new data option to the Extension Type field 

drop-down box found in the Properties Sheet.  

 

1. Open the Preferences pop-up box (Toolbar > Window menu > Preferences option).  

2. Navigate to the element you wish to change by expanding the Description or Taxonomic 

menus found in the Taxonomic Editor menu:  
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3. Click on the data field you would like to add to from the menu on the left hand side of the 

pop-up. The existing options associated with the drop-down list for that data field will 

appear in the main panel of the pop-up box. The example shown below is adding a new 

feature or data field to the overall Description. 

4. Click the New button. 

5. Give the new data field a Label, an abbreviation if desired and a description if desired. Only 

the data label is mandatory. 

6. Click the Finish button. 

 

 

 

Your new data option will be added to the drop-down box for the selected data field in the 

Properties Sheet. 

 

Please Note: The Remove option is not yet functional in this version of the Editor. 

 

4.1.3 Editing Options of Drop-Down Menus 
 

The Taxonomic Editor gives you the option to edit existing options of some drop-down boxes, as well 

as selecting/deselecting and the creation of new options as described in the above sections. Editing 

options allows you to change the name of the feature, abbreviation, and to add a description. This 

may be useful if your datasets has several users and you wish to provide information so that the data 

fields are used in a standardised way. 

 

Options found in the following menus can be edited: 
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Preferences > Description > Features for example “common name”, “distribution” and 

“ecology”. 

 Preferences > Taxonomic > Extension Types 

  

An example of how to edit a Feature of the Description menu is given below. For more information 

on the Descriptive element of the Taxonomic Editor see section 8.0 Adding Descriptive Data to 

Taxon on page 69.  

 

1. Open the Preferences pop-up box (Toolbar > Window menu > Preferences option).  

2. Navigate to the element you wish to change by expanding the Description or Taxonomic 

menus found in the Taxonomic Editor menu:  

 

 

 

3. Click on the data field you would like to edit so that it is highlighted. The example shown 

below is editing the Conservation feature. 

 

 

 

4. Click the Edit button: 
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The “Edit Feature” pop-up box will open. 

5. Edit the feature as desired. An example is given below: 

 

 

 

 

 

Original Feature details 

Edited Feature details 
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6. Click the Finish button: 

 

 

 

If you have edited the name of the Feature this will be immediately visible in the Features list: 

 

 

 

4.2 The Show View Menu 

 

The five panels of the Taxonomic Editor can be closed independently by clicking on the (x) icon on 

the right-hand side of the tab of each panel. For example: 

 



 

User Manual for Taxonomic Editor (Version 2.1.0.) 36 

 

 

The Properties Sheet, Taxonomic Tree, Datasource and User Manager panels can be reopened by 

clicking the panel name under the Show View menu.  

 

1. Click the Windows menu in the Toolbar. A drop-down box will appear. 

2. Move the mouse to the Show View option in the drop-down box.  

 

 

Toolbar > Window > Show View 

 

3. Click the panel option that you wish to open. 

 

The panel will re-open in the Taxonomic Editor window. 

 

Please Note: The Tabbed Properties option is for development purposes only and will be removed in 

the next version of the Editor. 

 

The Freetext panel is automatically re-activated after double-clicking on a taxon record in the 

Taxonomic Tree panel.  

 

Tip! If, when you select a panel in the Show View menu you still cannot see it in the Taxonomic 

Editor window, it may have been minimised. Check at the bottom right of the window for minimised 

panels: 
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5.0 Creating and Building your Database  

 

 

 

5.1 Note on terms and organisation within the Taxonomic Editor 

 

The Taxonomic Editor allows for the input of data in a hierarchical way. Databases within the 

Taxonomic Editor consist of Taxonomic Trees composed of linked child nodes representing the taxa 

in the tree: 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can have several Taxonomic Trees within your database, with unlimited numbers of taxa in each 

tree. Synonyms can be attached to taxa at any level in the tree. 

 

5.2 Creating a New Taxonomic Tree with Reference Details 

 

When using the Taxonomic Editor for the first time, you will need to create a new Taxonomic Tree. 

This will create a root within the Taxonomic Tree panel to which all following taxa records will be 

anchored. You can create a new Taxonomic Tree via the File menu: 

 

1. Click the File menu in the Toolbar > move the mouse to the New option; a drop-down menu 

will appear > Click the Taxonomic Tree option: 

 

 

 

Alternatively, you can access the New > Taxonomic Tree menu by clicking the right mouse 

button with the mouse arrow pointing within the Taxonomic Tree panel. 

This section tells you how to:  

• Understand the hierarchical system of a Taxonomic Editor database. 

• Create and build a new taxonomic treatment database by creating taxonomic trees 

and adding child taxa. 

 

Name of Project, programme etc 

Name of Child Taxa 

Taxonomic Tree e.g. Revision of Alyxia 

Child Taxon e.g. Alyxia 

Child 

Taxon 

Child 

Taxon

e.g. Alyxia marginata 

Name of Order, Family, Genus, 

species etc 

Synonym 

Synonyms can be attached to a 

Child taxon at any level in the 

hierarchy. 

e.g. Alyxia scabrida 



 

User Manual for Taxonomic Editor (Version 2.1.0.) 39 

 

2. Enter a label for the Taxonomic Tree. This could be the name of a project or publication, for 

example: 

 

 

You may enter reference details if you wish: 

 

3. Click the Browse button to the right of the Reference field: 

 

 

 

A new pop-up box entitled “Choose a reference” will appear. The cursor will appear in the 

search box by default. You can search here for a reference that you already have within your 

database: 

 

4. Type in the title of the reference; as you type, matching references from within your 

database will be filtered and shown in the “Matching items” box beneath the search box: 
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If you are creating a new database or do not have the required reference already input, you 

can choose to create a new reference by clicking the text at the bottom of the “Choose a 

reference” box: 

 

 

 

The “Create reference” pop-up box will appear: 

 

 

 



 

User Manual for Taxonomic Editor (Version 2.1.0.) 41 

Choose a reference type from the drop-down menu: 

 

5. Click on the arrow to the right of the Reference Type field; a drop-down list will appear: 

 

 

 

6. Scroll down the list; there are several methods for doing this: 

a. Use the up and down arrows on your keyboard; 

b. Use the mouse wheel if you have one; 

c. Click and drag the position icon at the right hand side of the drop-down list; 

d. Click the up and down arrows at the right hand side of the drop-down list. 

 

7. Click the desired reference type; the drop-down list will close. 

 

 

 

Alternatively to 6 and 7 above, type the first letter of the reference type you wish to select 

whilst the reference type field is highlighted. Matching options will be shown each time you 

press the initial letter. Continue until the desired option is shown in the reference type field. 

 

8. Enter the details of the reference in the title cache field: 
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9. Press the Return button on the keyboard or click the OK button; the “Create reference” box 

will close and you will be returned to the “Choose a reference” box: 

 

 

 

10. Press the Return button on the keyboard or click the OK button; the “Choose a reference” 

box will be closed and you will be returned to the “New Taxonomic Tree” box.  

 

If you wish to input reference details such as page numbers you can do so now: 

 

11. Click in the Reference Detail field; the cursor will appear. 

12. Type in the desired data. 

13. Click Finish or press Return on the keyboard: 
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The name of your new Taxonomic Tree will appear in the Taxonomic Tree panel: 

 

 

 

It is possible to have more than one Taxonomic Tree in your database. Simply create a new 

taxonomic tree using the method above. The trees will be listed in the Taxonomic Tree panel 

simultaneously. Also note that the Taxonomic Tree names are displayed in a lighter colour than the 

actual taxa names. You can use the arrows to the left of the taxonomic tree labels and the taxon 

nodes to show or hide the child taxon/taxa that are attached to that tree or taxon: 

 

 

 

 

5.3 Adding Taxa to your Taxonomic Tree the quick way  

 

Once you have created your first Taxonomic Tree, you can add taxa to build up your database 

according to your taxonomic treatment. You add taxa to your tree by creating New Taxon Nodes that 

are linked to both the tree and a parent taxon if appropriate. The following description is the 

quickest way to add a New Taxon Node to your tree: 

 

Point the mouse arrow at the Taxonomic Tree or the intended parent taxon of your new taxon. As 

you hover over the entries in the Taxonomic Tree panel they will become highlighted and a hand 

icon will appear. 

1. Click the right mouse button; a drop-down menu will appear. 

2. Point the mouse at the “New” option; a drop-down menu will appear. 

               Taxonomic Trees 
 Taxa 

                Show/Hide children arrow 
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3. Click New Taxon Node: 

 

 

 

4. Enter the name of the taxon, including authorship if you wish.  

5. Click the Finish button or press the Return button on the keyboard: 

 

 

 

The new taxon record will appear in the Taxonomic Tree panel and is saved automatically: 

 

 

 

You can continue new taxa to any node in the taxonomic tree in this way in order to build up your 

taxonomic treatment. To create and manage synonyms and other relationships, see Managing 

Taxonomic Relationships on page 62. 

 

If you want to open the taxon record to view the parsing status of the information you have input 

(see Parsing Status Feedback on page 49) or add to or edit the record (see the following section), 

simply double-click the taxon name in the Taxonomic Tree panel. 

In this example Alyxia will be 

the parent taxon of the new 

taxon, as indicated by the fact 

that it is highlighted. 
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5.4 Adding Taxa to your Taxonomic Tree using the File>New menu 

 

As well as the above method, you can also access the New Taxon Node box via the File > New menu 

on the toolbar. However, using this method you will need to manually input the Taxonomic Tree and 

the Parent Taxon (if any) of the taxon that you are inputting.  

 

1. Click on the File menu in the toolbar > New > Taxon Node: 

 

 

 

 The New Taxon Node pop-up box will open.  

2. Click the Browse button to the right of the Taxonomic Tree field: 

 

 

 

The “Choose a taxonomic tree” pop-up box will open. 

3. Enter a search term for the name of the Taxonomic Tree, for example the first letter of the 

name. As you type, matching taxonomic trees will be shown in the “Matching items” field 

below: 

 

 

 

Input a search term 

here 

 

As you type, 

matching items will 

be shown here 
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4. Click the name of the desired tree from the list in the “Matching items” field. 

5. Click OK; the pop-up box will close and the name of the Taxonomic Tree will be shown in the 

Taxonomic Tree field: 

 

 

 

If appropriate, you can now choose a parent taxon node to attach the new taxon to in the 

exact same way: 

 

6. Click the Browse button to the right of the Parent Taxon Node field: 

 

 

 

The “Choose a parent taxon node” pop-up box will open. 

7. Enter a search term for the name of the parent taxon, for example the first letter of the 

name. As you type, matching taxa from your selected Taxonomic Tree will be shown in the 

“Matching items” field below: 
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8. Click the name of the desired parent taxon from the list in the “Matching items” field. 

9. Click OK; the pop-up box will close and the name of the parent taxon will be shown in the 

Parent Taxon Node field: 

 

 

 

10. Click in the Taxon Name field. 

11. Enter the name of the taxon, including authorship if you wish.  

12. Click the Finish button or press the Return button on the keyboard: 

 

 

Input a search term 

here 

As you type, 

matching items will 

be shown here 
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The new taxon record will appear in the Taxonomic Tree panel and is saved automatically: 

 

 

 

You can continue new taxa to any node in the taxonomic tree in this way in order to build up your 

taxonomic treatment. To create and manage synonyms and other relationships, see Managing 

Taxonomic Relationships on page 62. 

 

If you want to open the taxon record to view the parsing status of the information you have input 

(see Parsing Status Feedback on page 49) or add to or edit the record (see the following section), 

simply double-click the taxon name in the Taxonomic Tree panel. 
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6.0 Editing your Taxa 

 

 

 

6.1 Parsing Status Feedback 

 

Parsing is the automatic separation of taxa data into its constituents parts, which is then stored 

separately in the database. Editing your taxa records may therefore involve checking and editing the 

parsing behaviour. The results of parsing your data will be displayed in the Properties Sheet.  

 

The Taxonomic Editor will display the parsing status of a record when it is open in the Freetext 

panel.  If the taxon record you would like to check is not open, you can navigate and activate the 

record as described in The Freetext Panel  on page 23.  

 

The parsing status is shown in the form of warning icons to the left of the taxon name and lines 

beneath the taxon name in the Freetext panel. Hovering over a warning icon with the mouse arrow 

will reveal a more detailed messages (the messages shown below are examples). The colours of the 

icons are also indications of the type of warning. There are three possible parsing states: 

 

6.1.1 Red warning icon = Parsing has been unsuccessful  
 

 

 

 

 

 

 

The taxon name will be underlined in red and there will be the red warning sign   to the left of the 

taxon name. This warning sign indicates that the parser has not been able to separate the text string 

into its constituent parts.  

 

You can rectify this by editing the taxon information, if necessary, in the Properties Sheet (see 

Dealing with Parsing Problems below). 

 

6.1.2 Orange warning icon = Parsing completed but checks are recommended 

 

This section tells you how to:  

• Check the parsing status of your taxon records. 

• Deal with parsing problems by editing basic fields in the Properties Sheet. 

• Delete a taxon from your taxonomic treatment. 

• Understand the bulk editor and how to use it to merge duplicate entries. 

• Save you work.  
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The taxon name will be underlined in orange and there will be an orange warning sign   to the left 

of the taxon name. This indicates that parsing has been successful, but that there is an element of 

uncertainty and you may want to check that the parser has correctly inserted the separate elements 

of your text string in the correct data fields. Hovering over the warning sign will give you details on 

which element to check. In the example above the warning says to check that the Rank status has 

been accurately determined. You have to check this in the Properties Sheet (see Dealing with 

Parsing Problems below). 

  

6.1.3 Black text only = No warning signal 
 

A successful parsing action will be apparent from the lack of a warning sign and no underline 

appearing beneath the taxon name in the Freetext panel. This indicates that the text string has been 

separated into its constituent parts with confidence.  

 

 

 

 

 

 

 

You may still check the parsing results in the Properties Sheet if you wish (see Dealing with Parsing 

Problems below).  

 

6.1.4 A Successfully Parsed Taxon Record 
 

A successfully parsed taxon record is given in the following example. You should note the Parsing 

Status = parsed, and the Uninomial, Specific Epithet and Authorship of the new taxon, shown in the 

Name Cache menu, have been parsed to the correct locations. 

 

No warning sign No warning signal 
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6.2 Dealing with Parsing Problems 

 

If you have received a warning sign after entering a new taxon (see Parsing Status Feedback above) 

or would like to check the parsing results you will need to check these data fields in the Properties 

Sheet. This panel is an editable display of the data fields that are contained within the database. A 

taxon record is displayed in the Properties Sheet when it has been activated in the Freetext panel. If 

the taxon you need to edit is not yet open you can activate it by double-clicking the taxon record in 

the Taxonomic Tree panel (see The Freetext Panel  on page 23 for further details). 

 

Initially you will need to expand the high level menus to reveal the relevant data fields and further 

menus below them. This will include at least the Accepted Name menu, but you may also need to 

expand the Name Cache menu depending on the information you are checking/editing.  

 

The menus can be expanded or minimised using the arrow icons to the left of the appropriate menu. 

These arrows are only activated when the mouse arrow is located within the Properties Sheet panel.  
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This version of the manual explains how to address problems with the basic data fields of Rank, 

Uninomial and Specific Epithet. The Parsing Status field at the top of the Properties Sheet will 

inform you of which field to check:   

 

 

 

 

 

Remember, if there continues to be a parsing problem after you have checked that the correct data 

is stored in the correct data field, the record can remain as it is; you will not be forced to eliminate 

the parsing problem before the data can be saved.  

 

6.2.1 Rank  
 

The Parsing Status of the field may ask you to check the Rank data field. If the rank is correct, there 

is no need to take any action. If the rank is incorrect, you can change it using the drop-down menu:  

 

1. Expand the Accepted Name menu using the arrow to the left of the menu.  

2. Click within the Rank data field; the field will be activated and a drop-down menu arrow will 

appear at the right of the field. 

3. Click on the drop-down menu arrow; the data options for the Rank field will appear. 

4. Navigate to the correct rank value using the bar at the right hand side of the menu to scroll 

down if necessary. 

5. Click the correct rank value; the drop-down menu will close and the selected rank will be 

shown in the rank data field. 

6. Save the record (see Saving your Work on page 59). 

 

If you see this parsing status you 

should check the Uninomial and 

Specific Epithet fields 

If you see this parsing status you 

should check the Rank field 
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Note the many options in the Rank drop-down menu. This menu can be customised to show only 

those ranks which you are likely to use. See Show/Hide Options of Drop-Down Menus on page 29 

for further information. 

 

6.2.2 Uninomial and Specific Epithet 
 

In order for these fields to be visible, both the Accepted Name and Name Cache menus need to be 

expanded using the arrows to the left of the data field name:  
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If these fields are incorrect, they can be edited simply: 

 

1. Click in the relevant field; the field will become highlighted:  

 

 

 

2. Make the correction. 

3. Save the record (see Saving your Work on page 59). 

 

6.3 Adding the Nomenclatural Status of a Name using the Properties Sheet 

 

The Properties sheet of this version of the Taxonomic Editor will be changed significantly in the next 

version of the Editor. Therefore the manual will not go into detail about how it works and how to 

use it at this stage. However, it will give one example of how to enter data using the Properties 

sheet; how to assign a status to a taxon name, for example, illegitimate, invalid, valid.  

 

If the taxon you want to edit is not yet open you can activate it by double-clicking the taxon record in 

the Taxonomic Tree panel (see The Freetext Panel  on page 23 for further details). 

 

1. Expand the Accepted Name menu by clicking the arrow icon to the left of the field label: 

 

 

 

 The Accepted Name menu will expand. 

 

2. Click in the Nomenclatural Status field; the cursor will appear in the field and a drop-down 

menu arrow will appear at the right of the field. 

3. Click the drop-down menu arrow; the menu will appear: 
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4. To navigate to and select the nomenclatural status you have several options: 

 

a. Use the up and down arrows on the keyboard until the desired nomenclatural status 

is highlighted and press the return button.  

b. Navigate the menu by using the mouse to move the scroll bar to the right of the 

menu up and down, or if your mouse has a wheel you can also use that. Click on the 

desired nomenclatural status. 

c. Type the first letter of the name of the nomenclatural status, for example, “V” for 

“Valid”. The Editor will automatically jump to the first entry within the menu with 

that first letter. Repeat pressing the letter until the desired nomenclatural status is 

highlighted and press the return button.  

Please Note: for this method to work you must enter the letter before any selection 

has been made, i.e. when the Nomenclatural Status field is blank.  

 

The drop-down menu will close, your selection will be shown in the Nomenclatural Status 

field, and the text string in the Freetext panel will be updated: 

 

 

 

5. Save the record (see Saving your Work on page 59). 
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6.4 Deleting a Taxon 

 

There are two ways of deleting a taxon: 

 

1. Click on the taxon in the Taxonomic Tree panel > press delete on the keyboard > go to step 

3., or: 

2. Point the mouse arrow at the taxon name in the Taxonomic Tree panel and click the right 

mouse button; a drop-down menu will appear > click the Delete option.     

 

 

 

A pop-up box will appear asking you for confirmation to delete the taxon from the 

taxonomic view. 

 

3. Click the OK button: 

 

 

 

The taxon will disappear from the Taxonomic Tree panel. 

 

Please Note: You can delete a taxon even if it has child taxa attached to it; all the records will be 

deleted. You cannot undo this action so you should be sure that this is what you want to do. 

 

6.5 Bulk Editing 

 

6.5.1 About Bulk Editing 
 



 

User Manual for Taxonomic Editor (Version 2.1.0.) 57 

 
 

Toolbar > Bulk Editor menu 

 

The bulk editor allows multiple taxon records that share Names, References or Authors and Author 

Teams data to be edited. These data types are not easily edited in the course of normal taxon 

editing and are frequently referenced (shared) in several places within a dataset, therefore they are 

edited in a separate location.  

 

Furthermore References frequently contain a number of duplicate entries, for example, after a mass 

import, where multiple entries for a single object must be merged to insure data integrity. The Bulk 

Editor allows you to search for and merge duplicate reference records. 

 

The Bulk Editor consists of a search field and a list editor. The list is populated when a search is 

executed. The Property Sheet is used to display and edit details of the object which is currently 

activated; changes made in the Property Sheet are reflected immediately in the list.  

 

This version of the manual will explain how to edit the name of multiple taxa records. 

 

6.5.2 Bulk Editing Names 
 

The bulk editor allows multiple taxon records that share Names, References or Authors and Author 

Teams data to be edited. These data types are not easily edited in the course of normal taxon 

editing and are frequently referenced (shared) in several places within a dataset, therefore they are 

edited in a separate location.  

 

In this example, we search for all the taxa within a Genus and change the Genus name. 

 

1. In the Toolbar area, click on the Bulk Editor menu; a drop-down menu will appear. 

2. Click the Name option. 

 

 

 

You will notice that a new tab has opened in the Freetext panel titled Names. The tab has a 

search bar at the top and a blank space below which will display the results of your search. 

 

3. Click in search box. 

4. Enter a search term in the search box.  
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To find multiple variations for the same name it is best to use a shortened version of the 

name with the ‘wildcard’ icon, an asterisk (*). The Taxonomic Editor will return all records 

that match the initial letters you have input but with no restrictions on the following 

characters (see the example below). 

Press Return on the keyboard or click on the Search button to run your search. A list of 

matching records will appear beneath the search bar. 

 

 

 

You will also find that the Properties Sheet will display information regarding each entry in 

the search results when you double-click its name within the list: 

 

 

 

In order to now change the genus name of all the taxa displayed in the Names tab, double-

click through the list and edit the name in the Properties Sheet to the right: 

 

5. Double-click on a taxon from the list in the Names tab in the Freetext panel; the taxon 

record will be activated in the Properties sheet as shown above. 

6. Expand the Name menu by clicking the arrow icon to the left of the field label: 

 

 

 

7. Click in the Editable Cache field. 

8. Edit the taxon name as desired, for example: 
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9. Click the Save icon; the name will automatically be changed in the Names tab in the Freetext 

panel and in the Taxonomic Tree: 

 

 

 

You can now move down the list in the Names tab and edit all the names as described above. 

 

6.6 Saving your Work  

 

Any record that has been edited without being saved will be flagged with an asterisk in the Freetext 

panel to the left of the taxon name in the tab label: 

 

An asterisk indicates unsaved changes 

 

 

 

You can save your changes using the Save icon on the Toolbar and at the top left of the Taxonomic 

Editor window: 

 

 

Alternatively, hold the Control and S keys on the keyboard at the same time. 
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Please Note: If you have multiple taxon records with unsaved changes this method will only save 

changes in the currently activated record i.e. the record that is open in the Freetext panel. To save all 

unsaved changes in multiple records you need to select the Save All option found under the File 

menu: 

 

Click on the File menu in the Toolbar; the File drop-down menu will appear > Click on Save All. 

 

 

  

 

If you attempt to try to close an edited taxon record without saving your changes the Taxonomic 

Editor will give you a warning: 

 

 

 

Any changes to text in the Freetext panel will not appear in the Taxonomic Tree panel until the 

changes have been saved as above. Alternatively, you can refresh the taxonomic tree by right-

clicking anywhere in the Taxonomic Tree panel and selecting Refresh Tree: 

 

Point the mouse arrow anywhere within the Taxonomic Tree panel > Click the right mouse button; a 

drop-down menu will appear > Click the Refresh Tree option. 
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Right-click 
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7.0 Managing Taxonomic Relationships  

 

 

 

7.1 Adding a Heterotypic Synonym 

 

There is a quick and easy way of attaching synonyms to a taxon record: 

 

1. In the Taxonomic Tree panel, double-click the taxon to which you want to attach a synonym; 

this will open the record in the Freetext panel if it is not already open (see Activating Taxon 

Records on page 24 for more information). 

2. Click in the Freetext panel to the right of any text already entered. 

3. Press Return on the keyboard. 

 

Another text box will appear in the Freetext panel, below that of the root taxon/accepted name for 

which you are entering a synonym. You will notice the standard taxonomic synonym indicator (=) at 

the left hand side of the new text box within a green circle: 

 

 

 

If the synonym text box was opened in error, point the mouse arrow into the synonym text box and 

click the right mouse button; a drop-down menu will open > click on the Delete option: 

 

 

 

4. Enter the name of the synonym.  

5. Save the synonym (see Saving Synonyms below). 

This section tells you how to:  

• Add heterotypic and homotypic synonyms to taxa. 

• Save, delete and edit synonyms. 

• Change a synonym to an accepted name. 

• Change the position of taxa within a taxonomic tree. 

 

Right-click 
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7.2 Adding a Homotypic Synonym 

 

By default, a carriage return from a taxon record in the Freetext panel will create a new text box for 

a heterotypic synonym, as detailed above. Homotypic synonyms can be added using a drop-down 

menu: 

 

1. Point the mouse arrow into the text box for the taxon to which you are attaching a 

homotypic synonym and click the right mouse button; a drop-down menu will appear. 

2. Point the mouse at the New option at the top of the menu; a new menu will appear. 

3. Click on the Homotypic Synonym option: 

 

 

 

Another text box will appear in the Freetext panel, below that of the root taxon/accepted 

name for which you are entering a synonym. You will notice the homotypic synonym icon of 

(≡) inside a blue circle: 

 

 

 

6. Enter the name of the synonym.  

7. Save the synonym (see Saving Synonyms below). 

 

7.3 Saving Synonyms 

 

You can save synonym records by either: 

 

1. Pressing Control and S together on the keyboard, or by: 

2. Pointing the mouse arrow into the synonym text box and click the right mouse button; a 

drop-down menu will open > click on the Save option: 
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After you have saved the synonym name will appear in the Taxonomic Tree panel beneath 

the accepted name with a synonym symbol: 

 

 

 

Note that synonyms are shown in the Taxonomic Tree panel in a lighter font than accepted 

names, and the synonym symbol (=) applies to all types of synonyms. 

 

7.4 Editing Synonyms 

 

A synonym name is parsed in exactly the same way as a root or child taxon. However, in the 

Properties Sheet panel you will see that Synonym Name is seen at the top, rather than Accepted 

Name. The details of a synonym name can be expanded and edited in the Properties Sheet panel in 

the same was as a child taxon (see Editing your Taxa on page 49). 

 

 

 

 

 

 

 

 

 

 

 

Right-click 
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7.5 Deleting a Synonym  

 

1. The accepted name to which the synonym you wish to delete has to be open in the Freetext 

panel (see The Freetext Panel  on page 23 to learn how to search for and open a taxon 

record). 

2. When the record is open, point the mouse arrow into the text box of the synonym you want 

to delete within the Freetext panel. 

3. Click the right mouse button; a drop-down menu will appear. 

4. Click the delete option. 

 

 

 

5. Save your changes (see Saving your Work on page 59). 

 

7.6 Changing a Synonym to an Accepted Name 

 

1. The accepted name taxon record which has the synonym attached to it that you wish to 

change to an accepted name has to be open in the Freetext panel (see The Freetext Panel  

on page 23 to learn how to search for and open a taxon record). 

2. Right-click anywhere within the text box of the synonym in the Freetext panel; a drop-down 

menu will appear.  

3. Point the mouse arrow over the Change To option; a new drop-down menu will appear. 

4. Click the Accepted Name option: 

 

 

   

Right-click 
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5. Save your changes (see Saving Synonyms on page 63 above); your changes will appear in the 

Taxonomic Tree panel: 

 

 

 

7.7 Changing an Accepted Name to a Synonym 

 

1. The accepted name taxon record that you wish to change to a synonym has to be open in 

the Freetext panel (see The Freetext Panel  on page 23 to learn how to search for and open 

a taxon record). 

2. Right-click anywhere within the text box of the taxon record in the Freetext panel; a drop-

down menu will appear.  

3. Click on the option “Change Accepted Taxon to a Synonym”: 

 

 

 

 The “Choose the accepted taxon” pop-up box will open. 

 

4. Enter the name of the accepted name that you wish to attach the synonym to in the search 

bar at the top of the pop-up box; as you type, matching entries will be filtered automatically 

and will be shown in the “Matching items” box beneath the search bar: 

Right-click 
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5. Select the desired accepted name by either: 

a. Point the mouse cursor to the desired accepted name and clicking the left mouse 

button twice; or 

b. Point the mouse cursor to the desired accepted name; click the left mouse button 

once and then click the OK button. 

 

The “Choose the accepted taxon” pop-up box will close and the record that has been edited 

will be shown as a synonym in the Freetext panel and the Taxonomic Tree panel: 

 

 

 

 The change is automatically saved. 

 

7.8 Moving the Position of Taxa within a Taxonomic Tree 

 

If a taxonomic treatment has changed and you need to update your taxonomic tree to reflect this, 

this can be done easily via the Move Taxon (with Subtree) function. This function allows you to 

move a taxon with any associated synonyms and child taxa. 

 

1. Point the mouse arrow at the taxon name which you want to change within the Taxonomic 

Tree panel. 

2. Click the right mouse button; a drop-down menu will appear. 

3. Click the Move Taxon (with Subtree) option: 

 

Type the name of the 

accepted taxon here 

Matching entries will  

be shown here 
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4. The “Choose new parent” pop-up box will open. In the text box at the top of the box, enter a 

term to search for the parent taxon to which you would like to move the child to.  

As you type the Taxonomic Editor will automatically search for matching taxon names. You 

can also use (*) to search using part of the name, or (?) to see all entries. A list will appear 

with matching taxon names: 

 

 

 

5. Click on the name of the desired parent taxon. 

6. Click the OK button or press Return on the keyboard. Alternatively, simply double-click the 

name of the desired parent taxon. 

7. The location of the selected child taxon will be moved within the Taxonomic Tree and will be 

saved automatically: 
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8.0 Adding Descriptive Data to Taxon Record 

 

There is a variety of types of descriptive data that can be added to a taxon (shown below). If you do 

not need to use all of these kinds of data you can remove the available descriptive data types via the 

Preferences menu as explained in Show/Hide Options of Drop-Down Menus  on page 29. Due to the 

variety of data types available, examples will be given here rather than instructions specific to every 

data type. 

 

Please Note: The Descriptive Data element is under construction and there may be some changes to 

later versions of the Taxonomic Editor. 

 

8.1 Types of Descriptive Data 

 

The descriptive data tab allows you to attach descriptive data to each taxon within your taxonomic 

tree. The following types of data can be included: 

 

Abstract Discussion Observation 

Acknowledgements Distribution Occurrence 

Additional Publication Ecology Pathogen Agent 

Anatomy Etymology Phenology 

Biology and Ecology Host Plant Protologue 

Citation Individuals Association Specimen 

Common Name Introduction Synopsis 

Conservation Key Unknown Feature Type 

Cultivation Materials Examined Uses 

Description Materials Methods  

Diagnosis Multiple  

 

The format of the types of descriptive data varies; for some the data is input as freetext but for 

others data must be chosen from options given in drop-down menus.  

 

Please Note: The options given to you in the drop-down menus can be customised using the 

Preferences menu (see Show/Hide Options of Drop-Down Menus  on page 29). 

 

8.2 Opening the Descriptive Tab for a Taxon  

 

The descriptive data tab is located in the Freetext panel. A taxon has to be included in the 

Taxonomic Tree panel and has to be activated within the Freetext panel before descriptive data can 

be added to that taxon. 

 

Any taxon listed in the Taxonomic Tree panel can be opened in the Freetext panel by double-clicking 

it in the Taxonomic Tree panel. This is the equivalent of opening a word processing file within the 

database. The taxon record will be opened in the Freetext panel headed by a tab titled with the 

taxon name: 
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      Double-click here    and the taxon opens here      in a new tab 

 

 

The default tab open will be the Name tab 

 

To access the Descriptive data tab you need to click the “Descriptive” tab at the bottom of the 

Freetext panel:  

 

 

 

The Descriptive data tab will open: 
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8.3 Adding a Description Tree to a Taxon 

 

The taxon must first be activated in the Freetext panel; see the section above. To access the 

Descriptions menu do the following: 

 

1. Point the mouse cursor in the “Description Tree” box. 

2. Press the right-hand mouse button; a menu will appear: 

 

 

 

3. Click the option “New Description”: 

 

 

 

An entry will appear in the Description Tree and the “Description Details” box will open to 

the right of the Description Tree: 

 

 

 

 

 

Press the right-hand 

mouse button with the 

cursor pointing here 

Menu appears 
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8.4 Building a Description Tree by adding Descriptive Data Types 

 

A description tree must first be created for the taxon; see the section above. 

 

1. Point the mouse cursor at the entry in the Description Tree box. 

2. Press the right-hand mouse button; a menu will appear. 

3. Point the mouse cursor at the “New” option in the menu; a drop-down menu of all available 

descriptive data types will be shown: 

 



 

User Manual for Taxonomic Editor (Version 2.1.0.) 73 

 

 

4. Click on the descriptive data type that you wish to enter for the taxon, for example 

“Common Name”; the data type will be added to the Description Tree and its specific data 

entry box will be activated to the right of the Description Tree: 
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A customised Descriptive Tree consisting of different description types can be created in this way. As 

stated previously the format of the types of descriptive data varies; for some the data is input as free 

text but for others data must be chosen from options given in a drop-down menu. Therefore 

examples of how to input certain descriptive data types will be given in the following sections, rather 

than showing how to input data for each data type.  

 

8.5 Adding Common Name Descriptive Data to a Taxon Record 

 

Add the descriptive data type of “Common Name” as described in section 8.4 above. The Descriptive 

tab in the Freetext panel should look like this: 

 

 

 

Tip! Each individual panel of the Taxonomic Editor can be resized; if you are having difficulties 

viewing the entire Descriptions panel you can use the arrows which appear at the top, bottom, left 

and right of the panel to resize it (see 3.3.2 Changing Panel Sizes on page 22). In the Descriptions 

box, you can also change the ratio of the size of the Description Tree box on the left to the Details 

box on the right. If you hover the mouse arrow between the two boxes a left-right arrow will appear 

which allows you to perform the resize. 

 

1. Click in the “Language” field in the Common Name Details box; the field will be highlighted 

and a drop-down menu will appear: 
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2. Enter the first digit of the name of the language. The first language name that begins with 

that letter will be shown. Continue to enter the first digit of the name until the language you 

wish to select is shown in the highlighted box.  

 

For example, to input the language of the common name as “Thai”, after clicking and 

highlighting the Language field, press “T” on the keyboard. Repeat the pressing until the 

name “Thai” in shown the Language field: 

 

 

 

3. When the language you want to select is shown in the Language field, press return on the 

keyboard to confirm your selection; the drop-down menu will close and your selection will 

be shown in the Language field: 
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4. Click in the “Common Name” field in the Common Name Details box; the cursor will appear 

in the box. 

5. Type in the common name of the activated Taxon; the text will appear in the Common Name 

field: 

 

 

 

6. Save the changes by clicking on the Save icon: 

 

 

 

Please Note: the Common Name menu in the Description Tree is not visibly updated at this point. 

However, if you close the Common Name menu and then re-open it by clinking twice on the arrow 

to the left, you will see that the data you have input has been saved (see below). Also, you will 

notice that as you close the Common Name menu, the Common Name Details box to the right of the 

Description Tree will also close.  
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8.6 Adding a Species Description to a Taxon Record 

 

Add the descriptive data type of “Description” as described in section 8.4 above. The Descriptive tab 

in the Freetext panel should look like this: 

 

 

 

As with several other descriptive data types available, the description of a species is added as free 

text. 

 

1. Point the mouse cursor in the Description Details box; the cursor will appear. 

2. Type in your species description, for example: 

 

 

 

Tip! You can also cut and paste text from a word document or another database where you store 

taxonomic information. Simply highlight the text you want to copy from the original document, press 

Ctrl on your keyboard and then C whilst still holding the Ctrl button. Release both buttons. You have 
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just copied the text. Now click in the box of the Taxonomic Editor where you would like to paste the 

text and press Ctrl and then V whilst still holding the Ctrl button. The text will be pasted. 

 

3. Save the changes by clicking on the Save icon: 

 

 

 

Please Note: the Description menu in the Description Tree is not visibly updated at this point. 

However, if you close the Description menu and then re-open it by clinking twice on the arrow to the 

left, you will see that the data you have input has been saved (see below). Also, you will notice that 

as you close the Description menu, the Description Details box to the right of the Description Tree 

will also close.  

 


